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Notices

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://green.asus.com/english/REACH.htm

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:
+  This device may not cause harmful interference.

+  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:
+  Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

+  Consult the dealer or an experienced radio/TV technician for help.

R The use of shielded cables for connection of the monitor to the graphics card is required
to assure compliance with FCC regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.
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RF exposure warning

This equipment must be installed and operated in accordance with provided instructions and
the antenna(s) used for this transmitter must be installed to provide a separation distance of
at least 20 cm from all persons and must not be co-located or operating in conjunction with
any other antenna or transmitter. End-users and installers must be provide with antenna
installation instructions and transmitter operating conditions for satisfying RF exposure
compliance.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

Macrovision Corporation Product Notice

This product incorporates copyright protection technology that is protected by method

claims of certain U.S. patents and other intellectual property rights owned by Macrovision
Corporation and other rights owners. Use of this copyright protection technology must be
authorized by Macrovision Corporation, and is intended for home and other limited viewing
uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering
or disassembly is prohibited.

Lithium-lon Battery Warning

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.




Safety information

Disconnect the AC power and peripherals before cleaning. Wipe the Desktop PC using a
clean cellulose sponge or chamois cloth dampened with solution of nonabrasive detergent
and a few drops of warm water then remove any extra moisture with a dry cloth.

+ DO NOT place on uneven or unstable work surfaces. Seek servicing if the casing has
been damaged.

+ DO NOT expose to dirty or dusty environments. DO NOT operate during a gas leak.

+ DO NOT place or drop objects on top and do not shove any foreign objects into the
Desktop PC.

+ DO NOT expose to strong magnetic or electrical fields.

+ DO NOT expose to or use near liquids, rain, or moisture. DO NOT use the modem during
electrical storms.

+  Battery safety warning: DO NOT throw the battery in fire. DO NOT short circuit the
contacts. DO NOT disassemble the battery.

+ Use this product in environments with ambient temperatures between 0°C (32°F)and
35°C (95°F).

+ DO NOT cover the vents on the Desktop PC to prevent the system from overheating.

+ DO NOT use damaged power cords, accessories, or other peripherals.

- To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

+  Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

- Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

+  Ifthe power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.
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Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

9. DANGER/WARNING: Information to prevent injury to yourself
when trying to complete a task.

'\ CAUTION: Information to prevent damage to the components
. when trying to complete a task.

IMPORTANT: Instructions that you MUST follow to complete a
task.

NOTE: Tips and additional information to help you complete a
task.

N 9

Where to find more information

Refer to the following sources for additional information and for product and software
updates.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS website www.asus.com.

ASUS Local Technical Support

Visit ASUS website at http://support.asus.com/contact for the contact information of
local Technical Support Engineer.



Package contents

ASUS Essentio Desktop PC

Mouse x1

(&

Keyboard x1

Power cord x1

Support DVD x1

Recovery DVD x1

Tostietion Sude

Nero 9 burning software
DVD x1

Installation Guide x1

Warranty card x1

Antenna (optional) x2

% + If any of the above items is damaged or missing, contact your retailer.

- + Theillustrated items above are for reference only. Actual product specifications may vary
with different models.



Getting started

Welcome!

Thank you for purchasing the ASUS Essentio CM1530 HD Entertainment Desktop PC!

The ASUS Essentio CM1530 HD Entertainment Desktop PC provides extreme performance,
uncompromised reliability, and user-centric utilities. All these values are encapsulated in a
sleek and stylish system casing.

R Read the ASUS Warranty Card before setting up your ASUS Desktop PC.

Getting to know your computer

% lllustrations are for reference only. The ports and their locations, and the chassis color vary
L with different models.

Front panel

/ Click the number to view its
corresponding description.

ASUS CM1530 14



/ Click the number to
view its corresponding

0ODD cover. Push to eject the optical disk drive tray.
Secondary ODD cover. Push to open the optical disk drive tray.

USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

Power button. Press this button to turn on your computer.
Front I/0 ports cover. Pull to open the front panel.

Secure Digital™ / MultiMediaCard slot. Insert a Secure Digital™ card or
MultiMediaCard into this slot.

Memory Stick™ / Memory Stick Pro™ card slot. Insert a Memory Stick™ / Memory
Stick Pro™ card into this slot.

CompactFlash®/ Microdrive™ card slot. Insert a CompactFlash® / Microdrive™ card
into this slot.

Headphone port (lime). This port connects to a headphone or speaker.

Microphone port (pink). This port connects to a microphone.

Rear panel

description.

Chapter 1: Getting started
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10.
1.

12.

7

Voltage selector. Select the input voltage.
Power switch. Switch to turn ON/OFF the power supply to your computer.
Power connector. Plug the power cord to this connector.

USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

HDMI ports. These ports allow your computer to connect to an HDMI monitor or other
HDMI-compatible devices.

DVI-D ports. These ports are for any DVI-D compatible device and is HDCP compliant
allowing playback of HD DVD, Blu-ray, and other protected content.

Side Speaker Out port (gray). This port connects to the side speakers in an 8-channel
audio configuration.

Rear Speaker Out port (black). This port connects to the rear speakers in a 4, 6, and
8-channel audio configuration.

Center/Subwoofer port (orange). This port connects to the center/subwoofer
speakers.

Microphone port (pink). This port connects to a microphone.

Line Out port (lime). This port connects to a headphone or speaker. In a 4, 6, or
8-channel configuration, the function of this port becomes Front Speaker Out.

Line In port (light blue). This port connects to a tape, CD, DVD player, or other audio
sources.

Refer to the audio configuration table below for the function of the audio ports in a 2, 4, 6,
or 8-channel configuration.

Audio 2, 4, 6, or 8-channel configuration

Headset

2.channel 4-channel 6-channel 8-channel
LightBlue | Lineln | Line In | Line In | Line In
Lime I Line Out I Front Speaker Out I Front Speaker Out I Front Speaker Out
ik | Mem | Mic In | Mic In | Mic In
Orange I - I - I Center/Subwoofer I Center/Subwoofer
Black I - I Rear Speaker Out I Rear Speaker Out I Rear Speaker Out
Gray I - I - I - I Side Speaker Out

13. Expansion slot brackets. Remove the expansion slot bracket when installing an
expansion card.

14. VGA ports. These ports allow your computer to connect to a VGA monitor or other
VGA-compatible devices.

ASUS CM1530



15.

16.

ASUS WLAN Card. This optional WLAN card allows your computer to connect to a

wireless network.

LAN (RJ-45) port. This port allows Gigabit connection to a Local Area Network (LAN)

through a network hub.

LAN port LED indications

Activity/Link LED

Speed LED

OFF No link OFF 10Mbps connection
ORANGE | Linked | ORANGE | 100Mbps connection
BLINKING | Dataactivity | GREEN | 1Gbps connection

18.

19.

Air vents. These vents allow air ventilation.

ACT/LINK SPEED
LED LED

-

LAN port

DO NOT block the air vents on the chassis. Always provide proper ventilation for your

computer.

Optical S/PDIF_OUT port (optional). This port connects to an external audio output

device via an optical S/PDIF cable.
P/S Keyboard port. This port is for a P/S 2 keyboard.

Chapter 1: Getting started



Setting up your computer

This section guides you through connecting the main hardware devices, such as the external
monitor, keyboard, mouse, and power cord, to your computer.

Connecting an external monitor

Using the ASUS Graphics Card

Connect your monitor to the display output port on the discrete ASUS Graphics Card.
To connect an external monitor using the ASUS Graphics Card:

1. Connect a monitor to a display output port on the ASUS Graphics Card.

2. Plug the monitor to a power source.

ﬁ The display output ports on the ASUS Graphics Card may vary with different models.

ASUS CM1530



Connecting a USB keyboard and a USB mouse

Connect a USB keyboard and a USB mouse to the USB ports on the rear panel of your
computer.

Connecting the power cord

Connect one end of the power cord to the power connector on the rear panel of your
computer and the other end to a power source.

Chapter 1: Getting started



Turning your computer ON/OFF

This section describes how to turn on/off your computer after setting up your computer.

Turning your computer ON
To turn your computer ON:
1. Turn your monitor ON.

2. Turn the power switch ON, then press the power button on your computer.

Power button

3. Wait until the operating system loads automatically.

Turning your computer OFF
To turn your computer OFF:

1. Close all running applications.
2. Click on the Windows® desktop.

Click [EME:EULS| to shut down the operating system.
Turn the power switch OFF.

ASUS CM1530 17



Using Windows® 7

Starting for the first time

When you start your computer for the first time, a series of screens appear to guide you in
configuring the basic settings of your Windows® 7 operating system.

To start for the first time:

1. Turn your computer on. Wait for a few minutes until the Set Up Windows screen
appears.

From dropdown list, select your language. Click Next.

From the dropdown lists, select your Country or region, Time and currency, and
Keyboard layout. Click Next.

4. Key in unique names for the user name and computer name. Click Next.

5. Key in the necessary information to set up your password, then click Next. You may
also click Next to skip this step without entering any information.

% If you want to set up a password for your account later, refer to the section Setting up a
- user account and password in this chapter.

Carefully read the license terms. Tick | accept the license terms and click Next.

7. Select Use recommended settings or Install important updates only to set up the
security settings for your computer. To skip this step, select Ask me later.

8. Review your date and time settings. Click Next. The system loads the new settings and
restarts. You may now start using your computer.

ASUS CM1530 2.1
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Using Windows® 7 desktop

% Click the Start icon @ > Help and Support to obtain more information about Windows® 7.

Start
menu

Taskbar

Notification area

Using the Start menu

The Start menu gives you access to programs, utilities, and other useful items on your
computer. It also provides you with more information about Windows 7 through its Help and
Support feature.

Launching items from the Start menu
To launch items from the Start menu:

1. From the Windows® taskbar, click the Start icon @

2. From the Start menu, select the item that you want to launch.

/ You may pin programs that you want constantly displayed on the Start menu. For more
details, refer to the section Pinning programs on the Start menu or taskbar on this
chapter.

Chapter 2: Using Windows® 7



Using the Getting Started item
The Getting Started item on the Start menu - '

contains information about some basic tasks SuCh |8 ... i o i
as personalizing Windows®, adding new users, and P— B e
transferring files to help you to familiarize yourself = » o -
with using Windows® 7. -

=

To use the Getting Started item:
1. From the Windows® taskbar, click the Start
icon to launch the Start menu.

2. Select Getting Started. The list of available  Eea
tasks appears.

3. Select the task that you want to do.

Using the taskbar
The taskbar allows you to launch and manage programs or items installed on your computer.

Launching a program from the taskbar
To launch a program from the taskbar:

. From the Windows® taskbar, click an icon to launch it. Click the icon again to hide the
program.

% You may pin programs that you want constantly displayed on the taskbar. For more details,
- refer to the section Pinning programs on the Start menu or taskbar on this chapter.

ASUS CM1530
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Pinning items on the jumplists

When you right-click an icon on the taskbar, a
jumplist launches to provide you with quick-access
to the program’s or item’s related links.You may
pin items on the jumplist such as favorite websites,
often-visited folders or drives, or recently played
media files.

To pin items to the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that
you want to pin, then select Pin to this list.

Unpinning items from the jumplist
To unpin items from the jumplist:

1. From the taskbar, right-click an icon.

Frequent
(@[ Pin to this list Jacri
Tasks

= Resume previous list

@ Play all music

Windows Media Player
o Unpin this program from taskbar

2. From the jumplist, right-click the item that you want to remove from the jumplist, then

select Unpin from this list.

Pinning programs on the Start menu or taskbar

To pin programs on the Start menu or taskbar:
1. From the Windows® taskbar, click the Start icon
to launch the Start menu.

2. Right-click the item that you want to pin on the
Start menu or taskbar.

3. Select Pin to Taskbar or Pin to Start menu.

You may also right-click on the
icon of a running program on
the taskbar, then select Pin this
program to taskbar.

N

& Intermet Exple Open

o Microwh O Troubleshoot compntibity
% Micresolt Wo

:"WMWNW Fint Toskbar

o Windewamur Pt Sart Menu

50 Weindows Fox | % 5o i Sty Theeats
@ Windons Mes r
\J*Mw Festore previcus vensns
¥l Windews Upd

Ex' Micreioh Cafice Soehlote 3007

15 Whersaelt Qe PewerPoml 2007
= Mizreseh O#ice Word 2007

i Mlicrosoft Office Tocis
. Misrosatt fficeLive Add-in

1 ma

(@) AlManager1.07.00
= Pin this program to taskbar

Close window
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Unpinning programs from the Start menu
To unpin programs from the Start menu:

1. From the Windows® taskbar, click the Start icon to launch the Start menu.

2. From the Start menu, right-click the program that you want to unpin, then select
Remove from this list.

Unpinning programs from the taskbar
To unpin programs from the taskbar:

] @ Microsoft Office Word 2007

1. From the taskbar, right-click the program g
that you want to remove from the taskbar, o Unpin this program from taskbar
then select Unpin this program from -
taskbar.

Using the notification area
By default, the notification area shows these three icons:

Action Center notification

E Click this icon to display all the alert messages/notifications and launch the Windows®
Action Center.
Network connection

. This icon displays the connection status and signal strength of the wired or wireless network
connection.

m Volume
Click this icon to adjust the volume.

Displaying an alert notification
To display an alert notification:

- Click the Notification icon [, then click WV 1 mesage
the message to open it.

fj' Set up backup

Open Action Center

5:45 PM
9/7/2009

% For more details, refer to the section Using Windows® Action Center in this chapter.

ASUS CM1530
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Customizing icons and notifications

You may choose to display or hide the icons and notifications on the taskbar or on the

notification area.

To customize icons and notifications:

1. From the notification area, click on the arrow icon E

Click Customize.

customize.

| s | Sowst Comnis S

©

From the dropdown list, select the behaviors for the icons or items that you want

Selexct which icons and notifications. appear on the tasibar

o o
e g B £ g e el s g ol g gt 5 P Lk

W s e

T Pty 200

At s

[Reney

o e et cat s

i o g et

i i g vt s

e e etk s

i e gt kb e
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Managing your files and folders

Using Windows® Explorer
Windows® Explorer allows you to view, manage, and organize your files and folders.

Launching Windows® Explorer
To launch Windows Explorer:

1. From the Windows® taskbar, click the Start icon ﬁ to launch the Start menu.

2. Click Computer to launch Windows Explorer.

Breadcrumb bar View icon

—— Search bar
Toolbar —| — Preview icon
il
B Dzmmicech
peEmma
- Barmovabie Duk (1)
— s

Navigation — —{— View pane
pane

Exploring files and folders

To explore files and folders:

1. Launch Windows Explorer.

2. From the navigation or view pane, browse for the location of your data.

3. From the breadcrumb bar, click the arrow to display the contents of the drive or folder.

+ Cornputer # WIND (S} Mlhen o = | 4r | et thes )
Iee .
Orgunize v Iochudeinfibary v Sh | L s =~ @

il Datr medd, Type

- Favorites "
8 Desktop ke

8 Dowrdosds Mattnew

L Hecent Places Public

S Lwanes
¥ Documents

ASUS CM1530
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Customizing the file/folder view
To customize the file/folder view:

1. Launch Windows Explorer.

2. From the navigation pane, select the location of your

data.

From the toolbar, click the View icon &= ~.

4. From the View menu, move the slider to select how you

want to view the file/folder.

/ You may also right-click anywhere
on the View pane, click View, and

select the view type that you want.

Arranging your files
To arrange your files:

1. Launch Windows Explorer.

€ Extra Largelcons

| Largelcons

T =5 Medium lcons
E >  Zi Smalllcons
£ List
nge

4= Details

£ Tiles

:E Content
Arrange by »
View ] Extra large icons
Sort by 3 Largeicons
Refresh Medium icons
Pocte Small icons
Paste shortcut .

© Details

Share with » Thes
MNew » Content
Properties

2. From the Arrange by field, click to display the dropdown list.

3. Select your preferred arrangement type.

(Y -

Documents library

Chapter 2: Using Windows® 7



Sorting your files
To sort your files:
1. Launch Windows Explorer.
Right-click anywhere on the View pane.

From the menu that appears, select Sort
by, then select your preferred sorting type.

Grouping your files
To group your files:
1. Launch Windows Explorer.
Right-click anywhere on the View pane.

From the menu that appears, select
Group by, then select your preferred
grouping type.

Adding a new folder
To add a new folder:

1. Launch Windows Explorer.

Arange by 3
View »
Sort by v @ MName
Group by v Date modified
Refrech Type
Paste o
Paste shortcut ©  Ascending
Undo Copy CtrlZ Descending
Share with v More...
New »
Properties
Arrange by »
View »
Sort by 3
Group by » @ Name
Refresh Date modified
Paste Type
Paste shortcut o
UndoRename  Ctl+Z Phonss
Share with i Acending
© Descending
New > ‘
| More..
RO —

. Qrganize » Share with » B New fold
2. From the toolbar, click New folder. - i i
3. Keyin a name for the new folder.
Amnge by
View »
% You may also right-click anywhere ::w :
e on the View pane, click New > Reteesh
Folder. e
Paste thortout
Unde Rename Cd-T
Fhare with
Hew b Folder
Propeses #| Shomew
&
=]
L]
o
ASUS CM1530
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Backing up your files

Setting up a backup
To set up a backup:

1. Click E > All Programs > Maintenance > Backup and Restore.
2. Click Set up backup. Click Next.

e = System and Secunty » Backup and Restore =] oy |l Semen Contr ane P

Centrol Panel Home v
Back up or restore your files

% Crnte s system image Hackip
% Create a wystem repair dise Winderws Backup has net been set up. et up Backup
Hestorm

Windows could not find & backup foe this computer,

5 Setect another kackup ta reaces fies freem

FACOVES TYTEm SETTINgS OF YU COmQutes

3. Select your backup destination. Click Next.

4.  Select Let Windows choose (recommended) or Let me choose as your backup
mode.

% If you select Let Windows choose, Windows will not back up your programs, FAT-
- formatted files, Recycle Bin files, or temporary files that are 1GB or more.

5. Follow the onscreen instructions to finish the process.

Restoring your system

The Windows® System Restore feature creates a restore point where the computer’s system
settings are stored at certain time and date. It allows you to restore or undo changes to your
computer’s system settings without affecting your personal data.

To restore your system:

1. Close all running applications.

2. Click E > All Programs > Accessories > System Tools > System Restore.

3. Follow the onscreen instructions to complete the process.

2-10 Chapter 2: Using Windows® 7



Protecting your computer

Using Windows® 7 Action Center

Windows® 7 Action Center provides you with alert notifications, security information, system
maintenance information, and the option to automatically troubleshoot and fix some common
computer problems.

% You may customize the notifications. For more details, refer to the previous section
Customizing icons and natifications in this chapter.

Launching Windows® 7 Action Center
To launch Windows® 7 Action Center:

1. To launch Windows 7 Action Center, click ‘* 1message

the Notification icon E, then click Open
Action Center.

Hy Set up backup

Open Action Center

¥ 4 Combool Paned b Syabern and Secunky b Acken Center =]+

Canrel Panel Hema
Risview recent missig

Chings Adtion Cantarsattings ction Center han detected on
% Change User Accourd Contrel
. Security =

i el

Wiew peduimane efemmatien baintenance L
Set up hackup
i i st yp backoa
Your files are not beng backed up.
sz it Wienbovwd Blvchurp
I yous st o et proibleen fited. tey are of Ehase
ol Troutiehecting SR Becovery
»‘ Find and fix probivem Resioin yons compuer b an st
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Using Windows® Update

Windows Update allows you to check and install the latest updates to enhance the security
and performance of your computer.

Launching Windows® Update
To launch Windows® Update:

1. From the Windows® taskbar, click the Start icon : to launch the Start menu.
2. Select All Programs > Windows Update.

3. From the Windows Update screen, click the task that you want to do.

7} » Control Panel » System and Security » Windows Update + | 42 || Search Contret Panel A

Control Panel Home

‘Windows Update
Check for updates
Change settings

View update history @ Eum o autor:eat!c upc::ilng ;
3 s are not being instal automatical
Restore hidden updates P o Y

Tum on autematic updating to help improve the security and
performance of your computer and allow standard users te install

updates on this computer,
%' Turn on automatic updates

Let me choose my settings

Updates: frequently asked
questions

Most recent check for updates:  Never
Updates were installed: Never
Vou receive updates: For Windows only.

Get updates for other Microsoft products. Find out more

2-12 Chapter 2: Using Windows® 7



Setting up a user account and password
You may create user accounts and passwords for people who will use your computer.

Setting up a user account
To set up a user account:

From the Windows® taskbar, click E > Getting Started > Add new users.

1.
2. Select Manage another account.
3. Select Create a new account.
4. Key in the name of the new user.
5. Select either Standard user or Administrator as the user type.
6.  When done, click Create Account.
2, + User Accounts § Manage Accounts ) Create New Account -4 P
Name the account and choose an account type
The name will appear on the Welcome screen and on the Slarl menu.
Matthew|
& Standard user
Sandard account wers can use most soltware and change systern settings that do not affect othes wers or
the security of the compater,
Administrator
Adrmenistrators have complete access to the computer and can make any devres changes. Based an
netitication settngs, administraters may be asied to prevade their password es confamatinn hetore
making changes that sffect sther users,
We recommend thal you protect every account with a strang passward.
Why i a stanclarel account eeommensied?
| CreseAccount | [ Cance |
ASUS CM1530
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Setting up a user’s password
To set up a user’s password:

1. Select the user that you would like to set a password.
2. Select Create a password.

Kbl 2. + e Accounty b Mamage fccents § Change am Actoust 5

Make changes to Matthew's account

Key in a password and confirm it. Key in your password’s hint.

When done, click Create password.

', v Manage Srcounts » Change sn Azcount + Creste Passward |

Create a password for Matthew's account

Yo are ereatng a paviword for Matthew,
1 yous do this, encrypted fies, passwords fee

(TR rrT————

Te the fusure, sk Hake & pir ey dink

Wihe pacowssd containg capital letlers, thiy must b byped the same way every e,
How to eseate 8 v

hint wall be whe uses

What is & passweard hi

Cronts pasword Cancel
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Activating the anti-virus software

Trend Micro Internet Security is a pre-installed anti-virus software on your computer. After
activating it, you have a 60-day trial period before the software expires and you need to
purchase a licensed version.

To activate Trend Micro Internet Security:

1. Run the Trend Micro Internet Security application.

2 Carefully read the license terms. Click Agree & Activate.

3. Key in your e-mail address and select your location. Click Next.
4

Click Finish to complete the activation.

Getting Windows® Help and Support

Windows® Help and Support provides you with guides and answers in using the applications
in Windows® 7 platform.

To launch Windows® Help and Support, click E > Help and Support.

;_-)- Find an answer quickly

Enter a few words in the search box sbove.

Mot sure where 1o start?

Mare on the Windows website

5 Check gt the
of your Windows 7 PC

vt webitite, which has more informaticn, dewnloads, and ideas for getting the mast ot

(ad, More support optiont
M Offlipe Help =

% Ensure that you are connected to the Internet to obtain the latest Windows® online help.
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Connecting devices to your computer

Connecting a USB storage device

This desktop PC provides USB 2.0/1.1 ports on both the front and rear panels. The USB
ports allow you to connect USB devices such as storage devices.

To connect a USB storage device:

+  Insert the USB storage device to your computer.

Front panel

To remove a USB storage device:

1. Click ¥ from the Windows notification area on your

computer, then click Eject USB2.0 FlashDisk.

2. When the Safe to Remove Hardware message
pops up, remove the USB storage device from
your computer.

Rear panel

= g L) [

=  Open Devices and Printers

o  Eject USB2.0 FlashDisk

~ Removable Disk (F:)

@0 iV

1472002 |

@ Safe To Remove Hardware
The 'USB Mass Storage Device' device can
removed from the computer.

X\ X

now be safely

/A DO NOT remove a USB storage device when data transfer is in progress. Doing so may
¢ cause data loss or damage the USB storage device.

ASUS CM1530
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Connecting microphone and speakers

This desktop PC comes with microphone ports and speaker ports on both the front and
rear panels. The audio /O ports located on the rear panel allow you to connect 2-channel,
4-channel, 6-channel, and 8-channel stereo speakers.

Connecting Headphone and Mic

Connecting 2-channel Speakers

AUDIO
INPUTS
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Connecting 4-channel Speakers

AUDIO  AUDIO
INPUTS INPUTS

Rear
4 W v i N
)

o )

Connecting 6-channel Speakers

AUDIO AUDIO AUDIO
INPUTS INPUTS INPUTS

ONONO

Rear  Front Center/
Subwoofer

ASUS CM1530
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Connecting 8-channel Speakers
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Connecting multiple external displays
Your desktop PC comes with VGA, HDMI, and DVI ports and allows you to connect multiple
external displays.

R When a graphics card is installed in your computer, connect the monitors on the output
ports of the graphics card.

Setting up multiple displays

When using multiple monitors, you are allowed to set display modes. You can use the
additional monitor as a duplicate of your main display, or as an extension to enlarge your
Windows desktop.

To set up multiple displays:

1. Turn off your computer.

2. Connect the two monitors to your computer and connect the power cords to the
monitors. Refer to Setting up your computer section in Chapter 1 for details on how
to connect a monitor to your computer.

% For some graphic cards, only the monitor that is set to be the primary display has display
- during POST. The dual display function works only under Windows.

ASUS CM1530
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6.

Turn on your computer.

Do any of the following to open the Screen Resolution setting screen:

+  Click & > Control Panel > Appearance and Personalization > Display >

Change display settings.

+  Right click anywhere on your Windows desktop. When the pop-up menu appears,
click Personalize > Display > Change display settings.

Select the display mode from the Multiple displays: dropdown list.
+  Duplicate these displays: Select this option to use the additional monitor as a

duplicate of your main display.

+  Extend these displays: Select this option to use the additional monitor as an
extension display. This increases your desktop space.

+ Show desktop only on 1/2: Select this option to show the desktop only on

monitor 1 or monitor 2.

+  Remove this display: Select this option to remove the selected display.

& Oaplay » Screen Reschuicn

= | g [ Seach Conmal Fanel £

Change the appearance of your displays

|Landseape -

Dot
s oo ]
icate these dplers |
Thit it cursently you
L Shaw datktop anly en |
Shaw desidop anlyend
Hemave this disglay I

Click Apply or OK, then click Keep Changes on the confirmation message.

Display Settings

=)

Do you want to keep these display settings?

[ Keep changes ]E Revert I

i Reverting to previous display settings in 8 seconds,
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Connecting an HDTV
Connect a High Definition TV (HDTV) to the HDMI port of your computer.

+ You need an HDMI cable to connect the HDTV and the computer. The HDMI cable is
purchased separately.

+ To get the best display performance, ensure that your HDMI cable is less than 15
meters.

ASUS CM1530
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Using your computer

Proper posture when using your Desktop PC

When using your Desktop PC, maintaining the proper posture is necessary to prevent strain
to your wrists, hands, and other joints or muscles. This section provides you with tips on
avoiding physical discomfort and possible injury while using and fully enjoying your Desktop

PC.
Eye level to the top of
the monitor screen 1
<

90° angle
Foot rest

To maintain the proper posture:

Position your computer chair to ensure that your elbows are at or slightly above the
keyboard to get a comfortable typing position.

. Adjust the height of your chair to make sure that your knees are slightly higher than
your hips to relax the backs of your thighs. If necessary, use a footrest to raise the level
of your knees.

. Adjust the back of your chair so that the base of your spine is firmly supported and
angled slightly backward.

Sit upright with your knees, elbows, and hips at an approximately 90° angle when you
are in front of your PC.

Place the monitor directly in front of you, and adjust the top of the monitor screen within
your eye level so that your eyes look slightly downward.

Keep the mouse close to the keyboard, and if necessary, use a wrist rest for support to
reduce the pressure on your wrists while typing.

. Use your Desktop PC in a comfortably-lit area, and keep it away from sources of glare
such as windows and direct sunlight.

Take regular mini-breaks from using your Desktop PC.
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Using the memory card reader

Digital cameras and other digital imaging devices use memory cards to store digital picture or
media files. The built-in memory card reader on the front panel of your system allows you to
read from and write to different memory card drives.

To use the memory card:

1. Pull down both sides of the cover from the notch area to open it.

2. Insert the memory card into the card slot.

/ + Amemory card is keyed so that it fits in only one direction. DO NOT force the card into a
slot to avoid damaging the card.

+ You can place the media in one or more of the card slots and use each media
independently. Place only one memory card in a slot at one time.

3. Select a program from the AutoPlay window to access your files.

% + If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the
- taskbar, click Computer, and then double-click the memory card icon to access the data
onit.

+ Each card slot has its own drive icon and it is displayed on the Computer screen.

+ The memory card reader LED lights up and blinks when data is being read from or
written to the memory card.

4. When finished, right-click the memory card drive icon on the Computer screen, click
Eject, and then remove the card.

R Never remove cards while or immediately after reading, copying, formatting, or deleting
data on the card or else data loss may occur.

/ E\ To prevent data loss, use “Safely Remove Hardware and Eject Media” in the Windows
( notification area before removing the memory card.
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Using the optical drive

Inserting an optical disc
To insert an optical disc:

1. While your system is on, press PUSH on the drive bay cover to open the tray.
2. Place the disc to the optical drive with the label side facing up.

3. Push the tray to close it.

4. Select a program from the AutoPlay window to access your files.

% If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the taskbar,
click Computer, and then double-click the CD/DVD drive icon to access the data on it.

Removing an optical disc
To remove an optical disc:

1. While the system is on, do either of the following to eject the tray:
+ Press PUSH on the drive bay cover.
+ Right-click the CD/DVD drive icon on the Computer screen, and then click Eject.

2. Remove the disc from the disc tray.

ASUS CM1530
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Using the multimedia keyboard

(on selected models only)

7

ASUS SK-2045 keyboard

Keys Description

Launches Windows® gadgets.

Activates Windows® Flip 3D.

o

BEOO00 0

Reduces picture size in Windows®
Photo Viewer.

Increases picture size in Windows®

4 Photo Viewer.
5 Functions with keys F1~F12.
Press <Fn + F1> to launch Microsoft®
6.
Word.
7 Press <Fn + F2> to launch Microsoft®
! Excel.
8 Press <Fn + F3> to launch Microsoft®

PowerPoint.

Press <Fn + F4> to launch Microsoft®
Internet Explorer.

Press <Fn + F5> to launch Microsoft®

g -
Outlook.

o [E
Press <Fn + F6> to launch the
(28| Favorites folder in Windows® Internet
Explorer.

—_
=

Keys

12.

The keyboard varies with models. The illustrations on this section are for reference only.

Description

Press <Fn + F7> to launch Microsoft®
E MSN or, if not installed, connects to the

MSN download page.
Press <Fn + F8> to launch Windows®
@

Search screen.
E
E
4
O
©
©
©

O Launches Windows® Media Center.

Press <Fn + F9> to play or pause
playback in Windows® Media Player.

Press <Fn + F10> to stop playback in
Windows® Media Player.

Press <Fn + F11> to go to the previous
track in Windows® Media Player.

Press <Fn + F12> to go to the next
track in Windows® Media Player.

Decreases the system volume.

Increases the system volume.

Turns the volume’s mute mode on/off.

Launches Windows® Media Player.

The special function keys only work on Windows® Vista / Windows® 7 operating systems.
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ASUS-Razer Arctosa Gaming keyboard

Plays or pauses playback in a media
player.

Stops playback in a media player.

Goes to the previous track in a media
player.

Goes to the next track in a media
player.

Eal

w r b

Decreases the system volume.

o

Increases the system volume.

(=2}
=
) 4

Turns the volume’s mute mode on/off.

~

o

Switches profiles working with F1 ~
ol F10 keys.

+ The special function keys work on Windows® XP / Vista / 7 operating systems.

N

Install the driver before using the keyboard. Visit the Razer website at
www.razersupport.com to download the driver.
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BTC 6200C keyboard

Description

Enters into sleep mode. Press any key
to wake up your computer and return to
the previous working status.

Returns to the last page you viewed.

Goes to the next page you viewed
before.

Launches the default homepage in
Windows® Internet Explorer.

Launches the Favorites folder in
Windows® Internet Explorer.

Launches your default email application.

Decreases the system volume.

00000 0

Turns the volume’s mute mode on/off.

o @
10. @
. @
2. @
3. @

Goes to the previous track in a media
player.

Plays or pauses playback in a media
player.

Goes to the next track in a media player.

Stops playback in a media player.

7

+ The special function keys work on Windows® ME / 2000 / XP / Vista / 7 operating

e systems without installing a driver. For Windows® 98SE operating system, visit the BTC
website at www.btc.com.tw to download the driver.

Install Microsoft® Internet Explorer 5.0 or later versions before using the Internet keys.
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Connecting to the Internet

Wired connection
Use an RJ-45 cable to connect your computer to a DSL/cable modem or a local area network
(LAN).

Connecting via a DSL/cable modem
To connect via a DSL/cable modem:

1. Setup your DSL/cable modem.

/ Refer to the documentation that came with your DSL/cable modem.

2. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to a DSL/cable modem.

Turn on the DSL/cable modem and your computer.
Configure the necessary Internet connection settings.

% Contact your Internet Service Provider (ISP) for details or assistance in setting up your
- Internet connection.

ASUS CM1530
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Connecting via a local area network (LAN)
To connect via a LAN:

1. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to your LAN.

2. Turn on your computer.

3. Configure the necessary Internet connection settings.

% Contact your network administrator for details or assistance in setting up your Internet
- connection.
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Wireless connection (on selected models only)

Connect your computer to the Internet through a wireless connection.

k To establish a wireless connection, you need to connect to a wireless access point (AP).

% + Toincrease the range and sensitivity of the wireless radio signal, connect the external
- antennas to the antenna connectors on the ASUS WLAN Card.

+ Place the antennas on the top of your computer for the best wireless performance.

+ The external antennas are optional items.
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To connect to a wireless network:

Click the network icon . in the notification area to display the available wireless

networks.

Met comnected “

dﬂcmmm

Vrweiess Network L onnection -~
P
ol
$50-10 "

0acg W

Lo R E

Open Metwork and Shaning Center

Select the wireless network that you want to connect to, then click Connect.

Mt connected L B
:ﬂﬂ Cennectiens we sealable
Woweleyy, Network ( onmeston -
WL -N0gV2
4, Conmnect sutomaticatly @
Ao WIR ol
PEEE, -
oRoG i
5010 o
ana o
5040 7
Open Network and Sharing Center

You may need to key in the network security key for a secured wireless network, then

click OK.

Type the network security key

Security key:

Chapter 5: Connecting to the Internet



4. Wait while your computer is connecting to the wireless network.

Connecting to WL-530gV2 ..

.

5. The wireless connection is established successfully. The connection status is displayed
and the network icon displays the connected status.

Weeless Netnerk Cenmection -

WL-530gV2 Connected ol
A WL M =
& e r
defauh -
50-130 |
DAY il
5030 <

aha e

Open Network snd Sharing Ceter
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Using the utilities

ASUS Al Manager

ASUS Al Manager is a utility which gives you quick and easy access to frequently-used
applications.

Installing Al Manager
To install Al Manager:

1. Place the support DVD in the optical drive. If Autorun is enabled, the Drivers installation
wizard appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Al Manager folder in
the support DVD.

2. Click the Utilities tab, then click ASUS Al Manager.
3. Follow the onscreen instructions to complete the installation.

Launching Al Manager
To launch Al Manager from the Windows® desktop, click Start > All Programs > ASUS > Al
Manager > Al Manager 1.xx.xx. The Al Manager quick bar appears on the desktop.

&= o] Y JET:

After launching the application, the Al Manager icon appears in the Windows® taskbar.
Right-click this icon to switch between the quick bar and the D iy
main window, and to launch the Al Manager either from the
quick bar or taskbar.

Switch to Quick Bar
Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit
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Al Manager quick bar

The Al Manager quick bar saves the desktop space and allows you to launch the ASUS
utilities or display system information easily. Click any of the Main, My Favorites, Support or
Information tab to display the menu’s contents.

= Exit button
@ ” & Switch to main Window
| Add to ToolBar

Main Support

My Favorites Information

Click the Maximize/restore button Il to switch between full window and quick bar. Click the
Minimize button = to keep the Al Manager on the taskbar. Click the Close button = 1o quit
the Al Manager.

Main

The Main menu contains five utilities: Al Disk, Al Security, Al Boosting, and Al Probe. Click
the arrow on the Main menu icon to browse through the utilities in the main menu.

e | R I

:' mﬁ’@"ﬁ:‘_\?ﬁ'r‘;l | Ig
el =lal” "1

ﬁ‘ Al Managenr

i

1

Click to display
items on the
right

Click to extend or restore

Click to display-
items on the left

Al Disk

Al Disk allows you to easily clear temporary IE files, IE cookies, IE URLs, IE history,
or the Recycle Bin. Click the Al Disk icon on the quick bar to display the full Al Disk
window and select the items you want to clear. Click Apply when done.

ﬁ i ._f@'}_% @ &
@ e | [ /ANDNESE

[ SIS A L you WantS ket
e

[ e — | [T Cowar Temporary € Files [T Cisar i URLS) History
-
[ CieariE Cookdes [~ ClwariE History
-s' sy [~ Ciewr Recycls Bin [~ Cinar Fiecantly pened Fies
V== oo
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Al Security
Al Security enables you to set a password to secure your devices, such as USB flash
disks and CD/DVD disks, from unauthorized access.

To lock a device:

1. When using Al Security for the first time, you are asked to set a password. Key in
a password with at most 20 alphanumeric characters.

2. Confirm the password.
3. Key in the password hint (recommended).
4. When done, click Ok.
D s .ﬁr'&’l @ &
@ A !r‘."\.-l'l Seclipity

Suppon
[ Ingul e b wer ilas barglh ie 20 chars

Indoimstion
| Re-rcut new oasswoie
|
5 Jniny Input P passweed hint

5. Select the device you want to lock, then click Apply.
6. Key in the password you have set previously, then click Ok.

To unlock the device:
1. Deselect the locked device, then click Apply.

2. Key in the password you have set previously, then click Ok.

To change the password:

Click Change Password, then follow the onscreen instructions to change
password.
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Al Booting
Al Booting allows you to specify the boot device priority sequence.

To specify the boot sequence:

1. Select a device, then click the left/right button to specify the boot sequence.
2. When done, press Apply.

Al Probe
Al Probe automatically detects and displays the motherboard and CPU temperatures,
CPU fan speed, and the voltage output. You can adjust the values as you need.

Click the Temperature, Voltage, or Fan Speed tab, then select an item to enable and
change the value by dragging the bar.

O- 8808

ii o .m...-.. ._'5___' 2 ‘
e T eeerrtre | - voge | e 1

R = ==

B - e

, Asue Uity B L - —— 'l:‘

i — D e L
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My Favorites

My Favorites allows you to add applications that you frequently use, saving you from
searching for the applications throughout your computer.

To add an application:
1. Click Add, then locate the application you want to add to My Favorites.
2. Click Open on the file location window. The application is added to My Favorites list.

Right click on the application icon to launch, delete, or rename the selected application. You
can also double click to launch the selected application.

Support

Click any links on the Support window to go to the ASUS website, technical support website,
download support website, or contact information.

T
) e
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Information

Click the tab on the Information window to see the detailed information about your system,
motherboard, CPU, BIOS, installed device(s), and memory.

@. o, | [ S |
a Suppent Manufachusr  ASUISTeK Compuier ING
Moherboarnt  CG5290
B T CPLU Genuine imeiR] CPU 000 @ 2 STGHT
' Indramaticn o AecEn Megarens nc
Var o7
RAM 2030 M8
»—
i —5—
ASUS Utility
g
3 -
@ .= &
CFU Ll EPU-4
- v =
. -
s Asu Uty
— 8 — ‘
CPU Level Up

CPU Level Up allows you to overclock immediately with OC profile presets in
Windows® environment without the hassle of entering the BIOS setup.

To launch CPU Level Up:

1. Launch Al Manager.
2. Click Asus Utility, then double-click CPU Level Up.
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EPU-4 Engine
ASUS EPU-4 Engine is an energy-efficient tool that provides you with a total system

power-saving solution. It detects the current computer loading and intelligently adjusts
the power usage in real-time. It automatically adjusts the power usage for the CPU,
VGA card, hard drives, and CPU fan. It provides you with these modes to choose from:
Auto, High Performance, and Maximum Power Saving Mode.

To launch EPU-4 Engine:

1. Launch Al Manager.
2. Click Asus Utility, then double-click EPU-4 Engine.

ASUS CM1530
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ASUS Update

The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® environment.

+ ASUS Update requires an Internet connection either through a network or an Internet
Service Provider (ISP).

+ This utility is available in the support DVD that comes with the motherboard package.

Installing ASUS Update
To install ASUS Update:

1. Place the support DVD in the optical drive. The Drivers menu appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Update folder in the
- support DVD.

2. Click the Utilities tab, then click Install ASUS Update.

3. Follow the onscreen instructions to complete the installation.

% Quit all Windows® applications before you update the BIOS using this utility.

Updating the BIOS
To update the BIOS:

1. From the Windows® desktop, click Start > Programs > ASUS > ASUS Update >
ASUS Update to launch the ASUS Update utility.

2. From the dropdown list, select any of the updating process:

Updating from the Internet
a. Select Update BIOS from the Internet, then click Next.

b.  Select the ASUS FTP site nearest you to avoid network traffic, or click Auto
Select then click Next.

c. From the FTP site, select the BIOS version that you wish to download then click
Next.

% The ASUS Update utility is capable of updating itself through the Internet. Always update
the utility to avail all its features.

Updating from a BIOS file
a. Select Update BIOS from a file, then click Next.

b. Locate the BIOS file from the Open window, then click Open.
3. Follow the onscreen instructions to complete the updating process.
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ASUS MyLogo2™

The ASUS MyLogo2™ utility lets you customize the boot logo. The boot logo is the image
that appears on screen during the Power-On Self-Tests (POST). ASUS MyLogo2™ is
automatically installed when you install the ASUS Update utility from the Support DVD.

R + Obtain the latest BIOS file from the ASUS website at www.asus.com.

+ You can create your own boot logo image in GIF file format.

To launch ASUS MyLogo2™:

1. Launch the ASUS Update utility. Refer to the section “ASUS Update” in this user
manual for details.

Select Options from the drop down menu, then click Next.

Check the option Launch MyLogo to replace system boot logo before flashing
BIOS, then click Next.

4. Select Update BIOS from file from the drop down menu, then click Next.

When prompted, locate the new BIOS file, then click Next. ASUS MyLogo window
appears.
6. From the left window pane, locate the

image that you want to use as your boot
logo. Click Next.

7. From the Ratio dropdown list, select your
desired size for the boot logo. Click Next.

8.  The system starts updating the BIOS and
loading the new boot logo.

9.  After the updating process, the system
restarts and displays the new boot logo
during POST.
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Nero 9

Nero 9 allows you to create, copy, burn, edit, share, and update different kinds of data.

Installing Nero 9
To install Nero 9:

1.
2.

7

3.

Insert the Nero 9 DVD into your optical drive.

If Autorun is enabled, the main menu appears automatically.

nero !wiii Bosnabim | Comeraten | 00 | wacki
"
: - !
m‘:J Welcome 1o co |gt
™ | Nero Startsmant mplete your
“@ tasks quickly
o and easily
Manage your projects
step-by-step with the
application buncher
that does it all
Special Tfunctions
n eatier!
a ' 5] e

9 DVD.

If Autorun is disabled, double-click the SeupX.exe file from the main directory of your Nero

From the main menu, click Nero 9 Essentials.

neroog
Essentials
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4. Select the language you want to use for Installation Wizard. Click Next.

5. Click Next to continue.

Please pnter your serial number for Nero 9 Fssentiale

LMD 2- KOBK-ACIL- TMIU- 232H-CO25-OAN3-APEZ- 5441 [

6.  Tick | accept the License Conditions. When done, click Next.

ctmprang s

, e Excrem, D,
T Wt tis
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7.

Select Typical then click Next.

Tick Yes, | want to help by sending anonymous application data to Nero then click
Next.

Help us to Enhance Nero Software

(RRRRES RS,

When done, click Exit.

Heoo T isertal - nstaltion e S

Installation Successful

)
N
o
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Burning files
To burn files:
1.

From the main menu, click Data Burning > Add.

nero Wil loonto i oo Wb
A
S -
e D P Mylne
Cepry Dot
A | ) ] [0 Y™
Hee — o
S P s P S 1~ ,” |
HEWS MH wn-c-n-q et
2. Select the files that you want to burn. When done, click Add.
% Bk s Tl i A A - ——
WEo-s “Tir || Seoth Gk w
Organize ». New foldes =~ @
e S s T :
M Deshicp | Syitern Folder
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W Becent Pleces TGS
Systern Folder L
. | '
J‘ i Lymern Folder R
= Fictures Q’
B viees _
8 Comnputer
& van ici °
o DATA [} .n'l 0'
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3. After selecting the files that you want to burn, click Burn to burn the files to a disc.
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Recovering your system

For more details about using Nero 9, refer to the Nero website at www.nero.com

The bundled Recovery DVD assists you in reinstalling the operating system and restoring it

to its original working state.

A
A\

settings.

To recover your system:

All data will be lost during the recovery process. Before recovering the system, ensure
\ that you back up all your data and take note of any customized settings such as network

1. Turn on your ASUS Desktop PC. When the ASUS logo appears, press <F8> to enter

the Please select boot device menu.

2. Insert the recovery DVD into the optical drive and select the optical drive (CDROM:
XXX) as the boot device. Press Enter and then press any key to continue.

3. Wait until the Hard-Disk Information screen appears. Select where to install a new

system. Options are:

Recover system to a partition

This option deletes only the partition you selected, allows you to keep other partitions,
and creates a new system partition as drive “C.” Select a partition and click NEXT.

Recover system to entire HD

This option deletes all partitions from your hard disk drive and creates a new system

partition as drive “C.” Select and click Yes.
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Tick | accept then click Next.
Follow the onscreen instructions to complete the recovery process.

Click OK on the confirmation message to eject the disc from the optical drive and the
system restarts.

After the system restarts, Windows® 7 begins its system configurations. Follow the
onscreen instructions to complete the process, and the system automatically restarts.

R This recovery DVD is for ASUS Desktop PC only. DO NOT use it on other computers. Visit

the ASUS website www.asus.com for any updates.

Quickly recover your system

1.

Turn on your ASUS Desktop PC. When the ASUS logo appears, press F9 to enter
System Recovery.

2. Windows is loading files is shown. Wait until the Recovery CD/DVD window
appears.

3. Follow the onscreen instructions to complete the recovery process. After the system
reboots, display resolution and system settings are restored to their default values.

ASUS CM1530



Troubleshooting

Troubleshooting

This chapter presents some problems you might encounter and the possible solutions.

? My computer cannot be powered on and the power LED on the front
panel does not light up

Check if your computer is properly connected.
. Check if the wall outlet is functioning.

. Check if the Power Supply Unit is switched on. Refer to the section Turning
your computer ON/OFF in Chapter 1.

? My computer hangs.

Do the following to close the programs that are not responding:

1. Simultaneously press <Alt> + <Ctrl> + <Delete> keys on the keyboard,
then click Start Task Manger.

2. Click Applications tab.

3. Select the program that is not responding, then click End Task.

If the keyboard is not responding. Press and hold the Power button on the top
of your chassis until the computer shuts down. Then press the Power button to
turn it on.

? I cannot connect to a wireless network using the ASUS WLAN Card
(on selected models only)?

Ensure that you enter the correct network security key for the wireless network
you want to connect to.

. Connect the external antennas (optional) to the antenna connectors on the
ASUS WLAN Card and place the antennas on the top of your computer
chassis for the best wireless performance.

?  The arrow keys on the number key pad are not working.

Check if the Number Lock LED is off. When the Number Lock LED is on,

the keys on the number key pad are used to input numbers only. Press the
Number Lock key to turn the LED off if you want to use the arrow keys on the
number key pad.
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No display on the monitor.

Check if the monitor is powered on.

Ensure that your monitor is properly connected to the video output port on your
computer.

If your computer comes with a discrete graphics card, ensure that you connect
your monitor to a video output port on the discrete graphics card.

Check if any of the pins on the monitor video connector is bent. If you discover
bent pins, replace the monitor video connector cable.

Check if your monitor is plugged to a power source properly.

Refer to the documentation that came with your monitor for more
troubleshooting information.

When using multiple monitors, only one monitor has display.

Ensure that the both monitors are powered on.

During POST, only the monitor connected to the VGA port has display. The
dual display function works only under Windows.

When a graphics card is installed on your computer, ensure that you connect
the monitors to the output port on the graphics card.

Check if the multiple displays settings are correct. Refer to section
Connecting multiple external displays in Chapter 3 for details.

My computer cannot detect my USB storage device.

The first time you connect your USB storage device to your computer,
Windows automatically installs a driver for it. Wait for a while and go to My
Computer to check if the USB storage device is detected.

Connect your USB storage device to another computer to test if the USB
storage device is broken or malfunctions.

I want to restore or undo changes to my computer’s system settings
without affecting my personal files or data.

The Windows® System Restore feature allows you to restore or undo changes
to your computer’s system settings without affecting your personal data such
as documents or photos. For more details, refer to the section Restoring your
system in Chapter 2.
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?  The picture on the HDTV is stretched.

It is caused by the different resolutions of your monitor and your HDTV. Adjust
the screen resolution to fit your HDTV. To change the screen resolution:

1. Do any of the following to open the Screen Resolution setting screen:

+ Click > Control Panel > Appearance and Personalization >
Display > Change display settings.

+ Right click anywhere on your Windows desktop. When the pop-up
menu appears, click Personalize > Display > Change display
settings.

2. Adjust the resolution. Refer to the documentation came with your HDTV
for the resolution.

3. Click Apply or OK. Then click Keep Changes on the confirmation
message.

? My speakers produce no sound.

Ensure that you connect your speakers to the Line out port (lime) on the front
panel or the rear panel.

Check if your speak is connected to a electrical source and turned on.

Adjust your speakers’ volume.

Ensure that your computer’s system sounds are not Muted.
If it is muted, the volume icon is displayed as m . To enable the system
sounds, click m from the Windows notification area, then click 4 .

+ Ifitis not muted, click m and drag the slider to adjust the volume.

Connect your speakers to another computer to test if the speakers arer
working properly.

?  The DVD drive cannot read a disc.

=)

1.

2.

Check if the disc is placed with the label side facing up.

Check if the disc is centered in the tray, especially for the discs with
non-standard size or shape.

Check if the disc is scratched or damaged.

The DVD drive eject button is not respond.

Click E > Computer.

&4

| DVD RW Dri
Right-click $ ™ then click Eject from the menu.
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